User Guide

If you've used Crystal, then you're familiar with the preset patches that come with it and
you have an idea of the kinds of sounds you can make with it. If you'd like to expand the
set of patches available to you, check out the "Patches" link at the top of the page to
download additional banks of patches. At some point though, you may want to create your
own sonic masterpieces and dive into patch editing with Crystal. If that's what you want,
you're in the right place.

How do you get started? The best place to begin is with the introductory tutorial in the
tutorials section below. That is probably the best place to start since it guides you through
a session and explains things to help you get started with editing. After you've mastered
that, you can use this page as reference manual - a place to explore the details or to get
specific questions answered about how certain features work. If you have questions or
would like to share ideas with other Crystal users, be sure to join the Crystal discussion
forum:

YaHOO!

GroUps
Jaln Now!

Click to subscribe to crystal-users

Tutorials

Here's an introductory tutorial for editing your own patches in Crystal.

This tutorial shows you how to get the most out of Crystal's Patch Bank Browser.

This tutorial covers copying voices.

This one is about the SawSquare oscillator type.

Here's a tutorial on how to get vowel sounds in Crystal.

Use soundfonts to expand the set of waveforms in Crystal. See this tutorial to learn how to
make own soundfonts.



http://groups.yahoo.com/group/crystal-users/join
http://groups.yahoo.com/group/crystal-users/join

Reference Manual

This reference manual contains the details on Crystal features and is the place to go to
explore what Crystal can do.

Description

Crystal is a semi-modular synth featuring both subtractive synthesis and frequency
modulation (FM) synthesis. It offers abundant modulation control with over 80 parameters
which may be modulated, multi-stage envelopes with graphical editors, extensive tempo
sync of envelopes/Ifo rates/delay times, built-in effects for chorus/flanging/comb
filtering/echoes, and a band splitter for effects processing by frequency band.
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Requirements

Crystal uses a lot of memory and cpu. It contains four 10 second delay effects, so between
that, the GUI graphics, and everything else, it requires about 20Mb of memory. So, on the
Mac 0S9, you'll have to add 20Mb to your Cubase memory allocation by using Get Info in
the Finder.

A G4 is the minimum cpu to use Crystal on a Mac comfortably (or a better than 500MHz
cpu if you're on a PC). Crystal is rather cpu-intensive. Simple modular synthesizers have
already been done. My goal with Crystal was to offer something more. So, by its very
nature, it will require more cpu than a basic modular synth.

Crystal is a plugin, which means it runs within a host, such as Cubase, Orion, Logic, Fruity
Loops, etc. If you're like me, you've already tried some presets before you've started
reading the documentation, so you've probably already heard some of the sounds that
Crystal can make. As you're listening to the presets, note that some of the pads, ambient,
and atmospheric presets take a while to evolve. By the way, when you listen to the
"Tempo Synced" presets, turn your song tempo up to a dance tempo of 140-150 in order
to get them to sound snappy. Also, note that the "Swell" programs are tempo sync'd, so
hit the note on the "1", and the sound will climax on the "1" of the next measure.

Program Editing

There are two ways to start editing a patch. The first way is to find an existing preset
patch and tweak it. The second way is to start from one of the patches named "Unused" at
the end of the presets menu. If you work by starting with an existing patch, use the utility
menu (next to the Poly button) to make a copy of the patch to work on. To do this, select
the patch you want to use as a starting point and choose "copy" from the Utility menu.
Then choose "Unused" from the preset menu and use the utility menu to paste the patch.
That way you can edit the patch without disturbing the original. The utility menu also has
a Revert which you can use as an undo: if, after editting a program, you want to undo the
edits, choose "Revert" to revert the program back to the state when you originally selected
it. Note that Crystal has very flexible signal routing. So much so that it is possible that you
could find yourself, while editing a program, overloading a filter with too much feedback
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and losing the audio output. the utility menu can also come in handy in that situation: If
you find yourself in that predicament, simply choose "Reset" from the utility menu to get
everything back to normal.

Ok, with that brief introduction out of the way, let's take a look at the Crystal editor
window. When opening the Crystal editor window, the first thing you will see is the
modulation page. Crystal is divided into 5 pages:

Modulation page:

The modulation page is where you specify how the controls are to be manipulated.
You use a modulation matrix to assign modulation sources to modulation targets.
A modulation target is generally a control from one of the voice pages or from the
Mixer page. A modulation source is either a MIDI controller that you use to
manipulate a Crystal control or a virtual performer. A virtual performer is like a
partner who manipulates controls for you, leaving your hands free to control other
things. Crystal offers two kinds of virtual performers: Low Frequency Oscillators
(LFQO's) and modulation envelopes. An LFO moves a control up and down in
various ways. A modulation envelope follows a script to move a control in a
predefined sequence of steps whenever you play a note. Using the modulation
matrix you assign a source to a target, which means from that point on the
control will be manipulated by the source.

3 Voice pages

Crystal has 3 voices. A voice is a source of a tone that is generated in response to
a midi note. Each voice has 1, 2, or 3 oscillators which serve as the ultimate
source of the sound. In addition, each voice has an amplitude envelope to
determine how the voice output level varies over time. Also, each voice has a filter
to add character to the sound.

Mixer page

The mixer page is where you combine the voices and add effects. The effects
include a frequency band splitter and 4 delays. The band splitter divides the input
signal into 4 frequency bands, each of which may be processed individually. For
example, you could send each band to a different delay. The delays may be used
to produce a variety of effects, including echoes, comb filters, flangers, phasers,
reverb, or chorus.

You navigate between the 5 pages by clicking on the tabs at the top of the window.

Modulotion  Volee | Voice 2 Viokeo 3 Mixor

The "general" pane (the set of controls in the upper left corner) remain the same as you
move from page to page, so they will be available from each page. You can also click on
the logo to get Crystal version information.
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The general pane has the following controls:

Voice on/off
The voice on/off buttons turn each of the 3 voices on or off. Use these to enable a
voice for a program, or to solo/mute voices while editing.
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Voice pre-mixer levels

These sliders control the output level of the voice, before it reaches the mixer.
Poly/mono button

The poly/mono button controls whether Crystal operates as a polyphonic synth
(starting a new note every time a key is pressed) or monophonic (any previously
sounding notes will be turned off when starting a new note). When polyphony is
turned on, there are 2 levels of polyphony available. Press the "Poly" button once
to turn on normal polyphony mode. In this mode, a total of 12 voices are
permitted. To enable more voices, press the button again and the button label will
show "Poly24". In this mode a total of 24 voices are permitted. Press the button
again to turn off Polyphony.

Parameter value display

The parameter value display shows the value of a parameter while it is being
modified. Use this to set a parameter to a specific value. Note that you can opt-
click (alt-click on windows) on controls to view the current setting without
modifying it. Also, when selecting a new program, the name of the program will
be displayed in the parameter display. Use the parameter value display to rename
a program: click on the parameter value display, then type in a nhew name. When
editting an envelope, the values of the point are displayed as a pair, with the time
followed by the value.

Utility menu

The Utility menu lets you copy programs from one program slot to another. You
can use this to create a new program based on an existing program. Revert is an
undo which will put the current program back to the state it was in when you
selected it, thus undoing any edits (including pasting a program) which you did
since then. You can also use this to do A/B comparisons between original and
editted versions of programs: select a program, make your edits, then copy the
program. Switch back and forth between the original and editted versions by
choosing Revert or Paste. The utilty menu also has items for copying a pasting
voices within a patch, so you can copy voice 1 to voice 2 for example, by choosing
"Copy Voice 1" followed by "Paste to Voice 2". Also, the utility menu has a Reset
item in case the sounds you're making get out of hand or the filters overload
leading to silence. Just choose Reset to put things back to normal.

The "Randomize Program" item of the Utility menu builds random programs as a
way to create new sounds. If you have some patience and try it over and over,
you may occasionally get something interesting :-). It differs from the randomize
and genetics features included in sequencers in that it keeps the Crystal envelopes
from becoming garbled. Be careful when using Randomize. It is possible to get
wild feedback loops. If you get an unpleasant screech, choose Reset from the
utility menu, which is just below Randomize.

The Legato portamento option causes portamento effects to only occur when
notes are played legato.

When the Legato mono option is enabled from the utility menu, playing a second
note in mono mode will not cause a new note to retrigger. Instead, the pitch of
the first note will jump to the pitch of the second note. This can be used for
interesting trills and arpeggios.

Program Selection menu

Crystal has built-in program selection controls, including "step up" and "step
down". These are the right and left pointing arrows on either side of the
parameter value display. Clicking on these will select the next program up and
down in the current bank. Next to the "step up" button is a downward pointing
arrow. Clicking on this will present a menu that allows you to choose any program
in the current bank.

Controls

Note to PC users: in the following, when it says "Cmd-click", read that as "Ctrl-click".
When it says "Opt-click", read that as "Alt-click".
Crystal uses 4 kinds of controls:

Drop down menus
Drop down menus (indicated by a downward pointing arrow) are used to select
from a set of choices. For example:

Sliders

Sliders are used to specify a value from a range. Cmd-click on a slider to set it to
its default value (generally the middle of the range). While dragging a slider, its

current value wil be shown in the parameter display in the general pane. Opt-click
on a slider to display its current value in the parameter display without modifying
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the value. On windows, you can also right-click to view the parameter value.
Shift-click on a slider to make high-precision adjustments. Use this if you're

havini trouble getting a specific desired value.

Buttons
Buttons turn parameters on and off. When on, it will be illuminated. When off, it
will be dark.

Envelope editors

These are used to edit envelopes. The envelope is a time graph, with time starting
at the left and proceeding to the right. The output level of the envelope (which
may be used to control a variety of things) is determined by how high or low each
envelope point is. For example, for a sharp attack to a voice, edit the amplitude
envelope so that it rapidly rises from the first point to the second.

The envelope will proceed from left to right until the red point has been reached.
It will remain at this point until the note is released. It will then proceed to the
last point. Use the shape menus at the right of the editor to vary the shape of the
output values of each segment as envelope proceeds from one point to the next.
Curve positive will change slowly at first, then more rapidly. Curve negative will
change quickly at first, then more slowly. The pulse shapes go up quickly to 1.0,
0.9, 0.75, or 0.5, then across 1/2 of the way to the next point, then down to the
level of the next point. the spike shapes go up quickly to 1.0, 0.9, 0.75, or 0.5,
then down in a negative curve, reaching the level of the next point at the point in
time 1/2 of the way to that next point. The Flat shape holds the level at one value
until the next point. With Inverse Pulse, the line from the point starts towards the
next point with the value of the first point. Then, half way to the next point, the
value drops to zero before rising again when the next point is reached. This is
very useful for arpeggios. See "Phased to Meet You" preset for an example.
Several of the "tempo synced" presets use pulses and spikes, so see those for
examples.

The envelope shape menus have a clue appended to the "curve positive" and
"curve negative" menu items to help you remember which direction each of those
choices goes. Curve positive has a "-<" to remind you that curve positive starts
out flat, then curves upward or downward (depending on whether the next point is
above or below the first point). Curve negative has a ">-" to remind you that
curve negative starts out curving upward or downward (depending on whether the
next point is above or below the first point) then finishes flat.

If you turn on the loop button, the envelope will return to the beginning when
sustaining instead of remaining at the red point. Specifically, it will go from the
red point to the yellow using the shape and time interval of the initial (blue)
envelope segment.

To edit the envelope, click and drag on any of the envelope points. Note that the

order of the points is fixed, so you won't be able to drag a point to a time before

the previous point, or after the next. Cmd-click and drag to move all the points in
unison: their relative positions will be maintained. Opt-click to constrain the time
positions to 1/4 of a grid unit. Ctrl-click to constrain the time positions to 1/3 of a
grid unit (mac only). Shift-click to make precise movements.



Use the scale slider to change the time scale of the editor. With sync off, the grid
units correspond to seconds. With sync on, the grid units correspond to 1/4 note
beats.

Use the Points menu to increase or decrease the number of points in the menu.
This is useful if you don't need the full complement of points, in which case fewer
points would make the envelope simpler to edit.

Use the envelope editor copy/paste menu to copy and paste envelopes between
editors or to load in a pre-defined envelope. Use copy/paste to ensure two
envelopes are the same as a means to synchronize two envelopes. Or, copy/paste
an envelope, then Cmd-click-drag or Cmd-opt-click-drag to make one envelope
twice as fast (or any other ratio) as another envelope.

Note that envelopes are generated and triggered whenever you play a note. This
means that if you are editting an envelope, you won't hear the results of your edit
until the next note plays.

Those are the basics that you'll need to know about to find your way around the Crystal
editor. Now we'll step through each of the pages, examining them in detail.

Modulation Page

LFOs

The LFOs section in the lower left is where you define your LFOs to be used in the
modulation matrix. Six LFOs are available and you choose the one to edit with buttons
labeled 1-6 at the top of the LFOs section.
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The LFO editor offers a number of parameters to affect the LFO. Most important is the
waveform, which is selected from the "Type" menu. Options include Sine, Random,
Triangle, Square, Saw Up, Saw Down, and Heartbeat. Sine, Triangle, and Square provide a
wave in that shape. Random will described below. Saw Up and Saw Down provide
sawtooth-shaped waves which ramp up and down, respectively. Heartbeat uses
mathematics from Chaos theory to emulate the beating of the human heart. After
selecting a type, select Center, Swing, and Rate. The LFO oscillates about the center
value. The amount that it varies from the center, or "swings" back and forth around the
center is determined by the Swing. So, for example a Center of 0.5 and a Swing of 0.5
would oscillate from 0 to 1. A Center of .4 and a Swing of .2 would oscillate from .2 to .6.

Note that a modulation source, such as an LFO, in Crystal is constrained to a range from 0
to 1. If you have your LFO defined to extend outside of this range, it will be clipped to
conform to the 0 to 1 range. You can use this for some interesting effects. See the
discussion below of Scale.

The rate determines how quickly the LFO completes each cycle. If the Sync button is on, it
will be interpreted as cycles per beat. Otherwise, the rate is defined as cycles per second.

The Random type LFO is a sine wave, but at random times the rate will speed up or slow
down and change direction. Random Rate determines how frequently, on average, the rate
will change. Random Mix determines how much the rate will vary. At 0 it will remain at the
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value specified by the Rate parameter. At 1 the rate will go as high twice the value of the
Rate parameter.

LFOs
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The Square LFO type also has RandRate and RandMix controls. This can be used to achieve
what is sometimes called sample and hold. This is an LFO which jumps to a random level,
stays there for a random amount of time, then jumps to another level. The SaturnScape
preset uses this to vary the FM index of voice 1 in interesting ways. To get this type of
LFO, choose "Square" for the LFO type and turn up the RandRate and RandMix controls.
RandRate controls the randomness of the times between jumps. RandMix controls the
randomness of the levels.

The Heartbeat type of LFO has a Width parameter and a Damp parameter. Adjust the

Width parameter to make the pulse wider, adjust the Damp parameter to make it bounce
more or less.

Use the Reset menu to determine how the "randomess" is reset. With this off, the
randomness continues indefinitely, meaning that every time you play a note, you'll get
something different. With the "Reset on note" option, the randomness will be reset
whenever you play a note meaning that you can get predictable random variations. That's
a good way to get something interesting, but it will sound the same whenever you play it
back. The String and Ice preset uses this to vary the Delayl pan in an interesting, but
reproducible way.

The Scale parameter increases the output of the LFO by the specified amount. At its lowest
level, 1, the output is unaffected. If increased to 2, it will double the output value of the
LFO. The result would be to change the first waveform pictured here to the second.
However, since modulation source values are clipped to 0 - 1, as shown here by the
dashed lines, the resulting waveform will be the third one in the picture.
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A Scale of 3 would mean the LFO is only below 1 1/3 of the time, and clipped at 1 2/3 of
the time. The Mercury Steroids preset uses this to vary the Voice 1 Filter Frequency.

The Pulse parameters apply a square LFO to the LFO. This can be used to create a
modulated tremelo that fades in and out with the primary oscillator of the LFO. The Pulse
parameter is the mix ratio between the primary oscillator and the square pulse. At 0, there
is no pulse, and at 1, they are mixed in equal quantities. The Pulse Rate parameter
determines the rate of the pulse. This can be especially effective with a Random type LFO.
The Who's In There preset uses this on LFO4 to apply a tremelo to voice 1 which varies
randomly.

The swing value of an LFO can be a modulation target, meaning you can modulate one
LFO with another. The Circus preset is an example of this.

The LFO display may be used to visualize the motion of the LFO. It shows the motion of
the selected LFO, including the values of the upper and lower ends of its range. If the LFO
motion extends beyond 0 or 1, that region will be displayed in gray, to let you know that
the value will be clipped at 0 or 1 while in that gray region. Also, the indicator will be
drawn as a faint ghost while in the gray, clipped, region.

Modulation Envelopes

Crystal offers 6 modulation envelopes. A modulation envelope is a general purpose
envelope which may be used in the Modulation Matrix as a source to modulate any target.
Choose the one you would like to edit with the "1" through "6" buttons above the envelope
editor.

Like all envelopes in Crystal, it is started (or restarted) whenever a note plays. It will be
released when the last note playing is released.

Modulation Matrix

The Modulation Matrix is where you assign any of the modulation sources to modulation
targets. There are twelve "slots" available, which means you can have any twelve sources
attached to any twelve targets. A source is an LFO, modulation envelope, or MIDI
controller. The twelve slots are divided into two pages of six slots each. Select the page
with the "1" and "2" buttons.

To attach a MIDI continuous controller to a Crystal modulation, choose "MIDI CC Learn"
from the menu under the "Source" heading in the Modulatoin Matrix. Then twiddle your
MIDI CC knob (or slider, or whatever). That control will automatically be tied that that
modulation routing and will control whatever you have selected for the corresponding
modulation target. Alternatively, if you know the controller number for your MIDI control,
you can select that directly from the Source menu.

The target is a Crystal parameter. If the parameter corresponds to a control in the editor
window, that control will turn blue to show it is under the control of a source in the
Modulation Matrix.

The selections in the target menu are mostly self-explanatory since they correspond to
Crystal parameters which are explained in this user guide. The "Filter Envelope Depth"
depth target controls the amount of influence the filter envelope has on the filter
frequency. This is very useful when attached to key velocity or an LFO to modulate the
amount of influence the envelope has over the filter's frequency. See the ResoFlyMW
preset for an example of using the key velocity to control how much the filter envelope
affects the sound. The "Splitl,2,3" target moves all 3 Splitter split points in unision,
maintaining their relative proportions.
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In each row, choose a source and a target. Use the Low and High parameters to determine
how deeply the source will affect the target. Setting the Low and High values close
together will result in a subtle effect, far apart will be extreme.

Each row of the modulation matrix has a mute button which may be used to suppress that
modulation routing. This is very handy when programming patches and you're trying to
isolate the effects of various modulations.

Generally, the meaning of 0 or 1 for the Low and High values is pretty obvious. There are
some exceptions, however. When modulating pitch, the value of 0.5 corresponds to the
original frequency. Watch the parameter display when adjusting the Low and High controls
for pitch - it will show you the value you've selected in semitones. So, to make a vibrato,
set the modulator to vary equally on either side of 0.5. For example, use an LFO with a
range from 0 - 1, and Low and High values a little below and a little above 0.5. The
Fatness preset does this with LFO 1 modulating the pitch of voice 1.

The Delay times are also an exception. When you modulate a delay time, you are not
directly modulating the value of the time parameter, but rather an amount which will be
subtracted from the delay time. When the modulation source is at 1, an amount equal to
the delay time will be subtracted from the delay time, resulting in zero. When the
modulation source is at 0, zero will be subtracted, resulting in the value of the delay time
parameter. The result is that you can modulate the delay time to produce chorus, phaser,
and flanger effects.

Another parameter which is an exception is the Voice Oscillator pulse width parameter.
When you modulate it, the modulation will range up to the position indicated by the pulse
width slider, so you can use the pulse width slider to control how widely the modulation
will range.

For example, the Springy preset modulates Delay 4 Time to produce a flanging effect. In
general, to get chorus type effects, set the delay time to a value of less than .050
seconds, and modulate the delay time with an LFO. Use shorter delay times for flanging
and phasing. Use high feedback to get a flanging sound. Then use the Mixer page to send
the voice(s) to the delay. These types of effects sound best when mixed equal parts dry
and delayed, so use the Mixer to set the voice and delay outputs to equal levels.
Experiment with different pan settings and multiple delays with slightly different
parameter values to get richer sounds.

Note that you can set the Low value to be higher than the High value. This "inverts" the
modulation source, so that when it is high it produces a low value, and vice versa. The
Moon March preset is an example of inverting a Modulation Envelope. It uses the
modulation envelope to modulate the Voice 2 Filter frequency as normal, but uses the
modulation envelope to inversely modulate Voice 1 Filter, with the result that the two
move in opposite directions. You can also use this in combination with the Scale and Pulse
parameters of the LFO to produce a modulator which is usually clipped at zero, but
occasionally rises, instead of the opposite as was described earlier in the LFO section.

When a parameter is under the control of the modulation matrix, its slider indicator will
change from green to blue. This will be your clue that is it controlled by modulation and
any changes you make to the slider won't take effect until the modulation control is
released from the modulation matrix.



Voice Pages
The voice pages are where you define the original tones that make sound in Crystal.
Oscillator

The oscillator section defines the waveform of the voice. Like the LFO, it offers waveform
types, with a somewhat different selection to choose from. Use the Type menu to choose
the waveform. The menu is divided into two sections. The upper section has synthesized
waveforms and the lower section has sampled waveforms. The synthesized waveforms
give you more control over the sound, but the sampled waveforms, since they are sampled
from nature, are more complex.
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SawSquare is a waveform which can be either a Sawtooth or Square wave, or a blend of
both. The Pulse Mix parameter controls the blend, with a value of 0 corresponding to
sawtooth, and 1 to Square. The Pulse Width parameter controls the width of the square
wave. Try modulating this with an Ifo to get a chorus-like effect. The Beast Belly preset
uses this technique. The Pulse Width will be at a minimum when the control is near a value
of .5. It will be at a maximum when the control is near 0 or 1. Note that you get a
different timbre when it is at 0 than 1. It will have a different kind of "hollow" sound, so
you can take advantage of that to achieve different sounds.

Sine, triangle, and noise produce those waveforms.

Clang is a metallic sound with inharmonic character. See the "granular" patches for
examples of clang. Unlike the other waveforms which are frequency modulated with a sine
wave, clang is modulated with a clang, so you can get some interesting sounds with FM.

WarmSaw is a variation on SawSquare which produces a warmer, more analog sound. Use
the PulseMix control to control the amount of warmth.

The sampled waveforms have Granular and Wave Density parameters which may be used
to produce a form of granular synthesis. Using this technique, the sound is divided into
"grains"”, which are then recombined into interesting new textures. Use the Granular
parameter to adjust the "graininess". The Grain Density parameter controls the amount of
overlap among the grains. And, of course, Granularity can be controlled from the Crystal
modulation matrix

Octave, Semitones, and fine tune control the pitch of the oscillator.

The Ring/FM button turns on Ring or Frequency Modulation. Press it once to turn on Ring
modulation. Press it again to turn on Frequency Modulation. Pressing it again turns off the
modulation and the button returns to its unlit state.

Ring modulation applies a second, unchanging oscillation to the oscillator. Use this for
percussive sounds.

In this Frequency Modulation mode, a second oscillator will run and its output will

modulate the frequency of the primary oscillator. The FM ratio parameter determines the
frequency of the modulator relative to the primary oscillator, so at a value of 0.5 it would
have a frequency half of the primary. the FM Index parameter determines how much the
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modulator affects the primary. This useful for bells and percussive type tones. The Bells
preset uses a voice with FM.

The Portamento parameter adds a "glide" to the pitch of each note so that it changes
gradually from one note to the next. Turn this control up to make the effect more
pronounced.

The "oscilloscope" display shows the waveform currently being produced by the Voice
module. It is the output of the oscillator after the filter and amplitude envelope have been
applied, but before the saturation.

When the oscillator type is set to SawSquare or WarmSaw, you'll see a Mogrify control.
This parameter controls a hard sync Hard sync gives the sound a gritty edge by resetting
the waveform at the period of the oscillator. As examples, check out the "Full House"
preset in the Vintage section and "Mushroom" in the "Motifs" section.

You can add your own waveforms to Crystal. If you've done so, you'll see a third section in
the Type menu which lists your waveforms. See the "Sample Import" section below to
learn how to import your own samples into Crystal.

Filter

The filter section controls the filter for each voice. Use the Type menu to select from a
variety of filter types. The filter includes a modulation envelope which will vary the
frequency of the filter between the values of the Lo Freq and Hi Freq parameters. The Hi
Freq parameter determines the frequency which corresponds to the upper limit of the
envelope. The Lo Freq parameter determines the frequency which corresponds to the
lower limit of the envelope. Watch the parameter display when moving points in the
envelope to see the current frequency for the point you are moving.

Fidter

Lofreg
HiFreg

@

Fatweatlon [|]
shopar ]

When the envelope is turned off, the Hi and Lo Freq parameters are replaced with a single
Freq parameter which controls the frequency of the filter (cutoff for high low pass filters,
center for notch and band pass filters).

The filter includes a Resonance (or Q for the non-resonant filter types) control. The
saturation control adds a tube-like distortion to the signal after the filter has been applied.
Note that the delays in the mixer section may be used as simple filters, in case you need
additional filters applied to the voice.

The filter section of each voice has a Shaper control which imposes a soft wave shaping
function on the voice before the filter is applied.

Note that you'll find two resonant low pass filters: ResLoPass and XResLoPass.
XResLoPass, provides a richer tone for those times when you want that squishy, liquid
sound, but uses slightly more cpu than ResLoPass.

Amplitude

The amplitude envelope controls the output level of the voice before the pre-mixer fader of
the general pane. The "VelSens" parameter controls the sensitivity of the note volume to
the note on velocity, in other words, how hard the note is struck.
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Mixer Page

The mixer page provides control over the blending of the voices and applies effects to
them.

The Delays section controls the four delay effects in Crystal.
Deloys e ]

Prospis [ Rl '..III"I "ml Hﬂf'lﬂ

[ beipt ] i Faaclnrk Lot g Fpniartlanick ! Filfasr Fravy ]

B ] = 4 I

+ . - -0 . —mn
e I | | | = = ill
LA mn El o | =l N

Each has a delay time parameter, which may be sync'd to tempo. When sync'd, the
parameter display will show a meter unit, for example 1/4 to indicate a quarter note. If
you are having a hard time selecting a desired meter unit, try holding down the shift key
for high precision mode. Each delay has a feedback control and a cross feedback control.
The delays are arranged in pairs, so that the crossfeedback of 1 goesto 2, 2to 1, 3 to 4,
and 4 to 3.

Each delay also has a filter, with a choice of filter type, a filter frequency (cutoff or center),
and Q to specify the steepness of the filter. Note that you can use the delays as filters, not
delays, by setting the delay time to zero, and the filter type as desired. That's a handy
way to get a bank of filters through which you can send the voices.

Delays can be used for a variety of effects, including echoes, comb filtering, chorus,
phasing and flanging. Echoes and comb filters are static effects: the time parameter is not
modulated. Simply set the delay time to a short value (less than .020 seconds) for a comb
filter or a long value (greater than .050 seconds) for an echo effect. Use the delay send
parameters to route one or more voices to the delay, then adjust the delay output level to
suit your taste.

Chorus, phasing, and flanging are modulated effects: the delay time is modulated to give
it @ moving characteristic. You do this by using the Modulation Matrix on the Modulation
page to attach a source (for example an LFO) to the delay time target. For a chorus, set
the delay time to a value between .020 and .050 seconds, then go to the Modulation page
and use the Modulation Matrix to assign an LFO to the delay time. For example, choose
Delay 1 and set the time to .030 seconds, set LFO1 to a slow sine wave, then choose the
first row of the Modulation Matrix on the Modulation page and select LFO 1 as the source
and Delay 1 time as the target. Set the Low and High values in row 1 of the Modulation
Matrix to 0 and 1.

Alternatively, you can simply choose "Delayl/LFO1 Chorus" off of the Delay presets menu
and it will perform the above steps for you automatically.

Then, turn up the Delay 1 send parameters (near the top of the Mixer page) to send your
voices to the Delay, and turn up the output level for Delay 1. For best results, mix the dry
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output level of the Voice and the level of delay in equal parts. Try adjusting pan values for
the delay, or feedback (or any delay parameters) to get different results. Set up more
than one delay for a chorus effect and send your voice(s) to all of them and mix and pan
them in different proportions to get interesting results.

Note that the Delay1/LFO1 presets use row 1 of the Modulation Matrix, Delay2/LFO2 use
row 2, Delay3/LFO3 use row 3 and Delay4/LFO4 use row 4. That way you can set up all 4
delays and still have 2 rows left in the Modulation Matrix for other purposes.

The delays be used as a Reverb. To use a delay as a reverb, set its filter type to "Reverb".
When in this mode the Feedback parameter will control the room size for the reverb, the
Delay Time parameter controls pre-delay, and the Filter Frequency parameter controls a
low-pass filter for the reverb. The Presets menu in the Delays section of the Mixer page
has options to set each of the 4 delays to reverb. For example, to use reverb choose
"Delay 1 Reverb" from the Delay Presets menu, then send one or more voices to Delay 1
using the Delay Send controls at the top of the Mixer page. Note that the reverbs are in
pairs, so if you'd like a stereo reverb, set delays 1 and 2, or 3 and 4, to Reverb mode, pan
them (1 or 3 to the left, 2 or 4 to the right), and send to both delays of the pair.

Mixer

The mixer is used to control the send levels of each voice to the band splitter, each of the
4 delays, and to output. Each delay has a mute button, which can be useful when you're
trying to discern the contribution each delay makes to the sound. It is organized into a
matrix with each row corresponding to an output source. The columns contain the controls
you can apply to each of these output sources.

The Splitter send controls how much of each voice is sent to the Splitter. Likewise, the
delay sends control how much of each voice or splitter band is sent to each delay. The pan
and output columns control the pan and gain settings for each source of output.
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Band Splitter

The Band Splitter is a four-way crossover filter that divides the input signal into four
bands. The frequencies at the dividing points between the four bands are determined by
the 1/2, 2/3, and 3/4 parameters. Watch the parameter display as you move these
controls to see what frequency you are selecting.
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The Band Splitter is very useful for taking the output from one or more voices (use the
mixer to send the output from a voice to the splitter) and routing only selected frequency
bands to a delay. For example, you could set the delays to produce 4 different chorus
effects, then send each of the 4 splitter bands to a different delay, with the result that
each frequency band has a different chorus effect applied to it.

The split points may be modulated individually from the modulation matrix, or you may
modulate the Split 1,2,3 target which varies all three split points in unison, maintaining
their relative values. The AstroStrings preset is an example of using the Band Splitter with
the Split 1,2,3 modulation target.

Patch Bank Browser
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The Patch Bank Browser, which is located in the "Browse" tab of the "Patches" section on
the Modulation page, enables you to browse through saved banks of Crystal patches and
import them with the click of a mouse.

To use this feature, place some .fxb files which contain Crystal patches into a folder named
"CrystalPatchBanks". The names of the files must end with ".fxb". If you don't have any
Crystal patch banks yet, you can find some on the patches page.

On the mac, put that CrystalPatchBanks folder into the Preferences folder in your System
Folder. On windows, put the CrystalPatchBanks folder into the plugins folder where you
have Crystal.dll. On OSX, put the CrystalPatchBanks folder into the <system
disk>/Users/<your user name>/Library/Preferences folder.

The Patches menu gives you access to all the patches in all the patch bank (.fxb) files in
your CrystalPatchBanks folder. You choose these patches by making a selection from the
Banks menu (to choose the patch bank), and then a selection from the Patches menu (to
choose the patch within that bank). When you make a selection from the Patches menu,
that patch is imported from the bank file into the current preset (as selected by the
Presets menu).

The left and right arrows below the Patches menu allow you to step through the patches
forward and backwards. If you add new bank files after you start Crystal, choose "Banks"
from the Banks menu to refresh the list of bank files in the menu. You can "undo" the
import of a patch by choosing "Revert" from the Utility menu (next to the Poly button).

Crystal offers the ability to write patches to a .fxb file from within Crystal. This export
feature works on .fxb files which are stored in your CrystalPatchBanks folder. Note also
that these feature only works with .fxb files which were created with at least version 2.3 of
Crystal.

To use this feature, select a patch you would like to write to a .fxb file, choose a bank from
the patch browser on the Modulation page, and choose the patch in that .fxb file you
would like to overwrite from the "Write" menu.

Wave Sequencing

Crystal offers 8-stage wave sequencing, meaning you can vary the waveform to be used
for an oscillator among 8 different pre-defined sampled waveforms. There is a "Wave
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Sequence" section in the preset patches included with Crystal which has 10 examples of
patches which use Wave Sequencing.

Here are the instructions for creating Crystal patches which use wave sequencing:

1. Select one of the unused presets at the end of the presets menu.

2. Go to the voice 1 page and set its oscillator type to one of the pre-defined
samples (the ones in the 2nd section of the oscillator type menu, starting with
Sync and ending with Vinyl).

3. Go to the modulation matrix on the modulation page and pick an unused row
(where the source and target are set to "Off". Choose "ModEnvelopel" for the
source and "Voice 1 Wave Sequence" for the target.

4. Go to modulation envelope 1 and set all the shapes to "Flat" by choosing "All
Flats" from the envelope presets menu to the right of the "Loop" button.

5. Now, move the points in modulation envelope 1 to select waveforms at various
points in time. The parameter display will show you the name of the waveform as
you move a point. I'd recommend snapping the points to a time value by holding
down the option key (alt key on windows) as you drag a point around.

6. Use the Wave Density control (in the Oscillator section of each voice page) to
control the crossfade time for each wave. The maximum cross fade time is 5
seconds, so watch the parameter display as you adjust the Wave Density. You
don't want the crossfade times to be longer than the sequence step times in the
modulation matrix (otherwise, the sequence will seem to skip steps).

7. Have fun. Things to try: copy the modulation envelope to the voice amplitude or
filter envelope and then make the filter or amplitude change in sync with the wave
sequence. Modulate 2 voices with the same wave sequence, but detune one voice
and pan the voices left and right.

Sample import
What it is:

Soundfont is a file format created by EMU. Files of this type contain sampled instruments
which may be played by soft synths like Crystal.

Crystal can import uncompressed SoundFont samples, thus enabling you to expand the list
of available waveforms in Crystal. To import soundfonts, create a folder called
CrystalSoundFonts and put some .sf2 files into that folder. On the mac 0OS9, put that
CrystalSoundFonts folder into the Preferences folder in your System Folder. On windows,
put the CrystalSoundFonts folder into the plugins folder where you have Crystal.dll. On
OSX, put the CrystalSoundFonts folder into the <system disk>/Users/<your user
name>/Library/Preferences folder. When you start your VST host, you'll see a third section
on your Oscillator type menu, which will include the sound fonts.

Also, Crystal provides hierarchical organization of your soundfonts. If you put the
soundfont files in a tree of folders, that tree will be reflected in Crystal's oscillator type
menu as submenus. Use this feature to organize your soundfonts into categories which are
easy to navigate from within Crystal.

There are a number good places to download soundfont files on the web. Try
http://www.hammersounds.net or http://www.thesoundsite.net. On windows, VSampler
(http://www.vsampler.com) may be used to create your own soundfonts. There are also a
number of good commercial sites that sell excellent sound fonts, including
http://www.soundfonts.com and http://www.sonicimplants.com

Crystal imports key and velocity mapping from SoundFonts, so you'll get full multisampled
sounds. The purpose of this feature is to expand the variety of waveforms in Crystal, but
the intention is not to make Crystal a full-fledged sample player. So, while samples, key
mappings, and velocity mappings are imported into Crystal, other settings, such as
envelope settings and effects are not. So, after you import, use Crystal's envelopes and
effects to mold the sound to your heart's desire.

Also note that the quality of soundfonts can vary, so don't be surprised if you get some
soundfonts that loop when they shouldn't or if you sometimes hit notes that are out of
tune.
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On the mac 0S9, you'll need to add to the memory allocation for cubase to accomodate
the sound fonts. Add up the sizes of your 4 largest sound font files in the
CrystalSoundFonts folder and add three times that number to the memory allocation for
cubase (or whatever your host is) using Get Info in the Finder.

A bit of advice regarding the use of soundfonts in Crystal:

Crystal is not intended to be a general soundfont player. Instead, it uses soundfonts as a
source of waveforms. The advantage to soundfonts is that the waveforms can be
multisampled, allowing you to get higher quality sounds than if you use .wav or .aiff files.

With that in mind, I would not recommend just blithely adding a lot of soundfont files into
your CrystalSoundFonts folder. Instead, be selective and only add ones with interesting
waveforms.

For one thing, simply dumping a bunch of soundfont files into your CrystalSoundFonts
folder will clutter your Oscillator Type menu with a lot of uninteresting waveforms. For
example, you'll probably end up with hundreds of sine waves :-).

For another thing, having a large number of soundfonts will slow down the launching of
Crystal.

So, start with the Crystal Sample ROM soundfonts in your CrystalSoundFonts folder. After
that, be selective when adding soundfonts and only put soundfonts which have interesting
waveforms into your CrystalSoundFonts folder.

Program morph

Program morph is a modulation target, which when modulated, morphs between two
programs: the one immediately before the current one in the preset list, and the one
immediately after. See the "Morph" preset as an example. Select "Morph" and move your
mod wheel up and down while holding a note. The program will morph between the
"Morph source 1" and "Morph source 2" programs. Parameters which can vary continously
(basically all the parameters in the modulation matrix target menu) will vary while you
hold down a note. Other parameters, for example envelope settings or oscillator type, will
vary when you play the next note.

Program Morph is a modulation target like any other, so you can modulate it with a variety
of things, including LFQO's. If you use an LFO though, be careful that the LFO in use has
similar settings in the two source patches. This is because the LFO parameters will morph
just like all the other parameters and you probably don't want the LFO that is controlling
the morph to be morphed radically during the morph.

You do have to pay some attention to the differences between the 2 source patches to get
glitch-free morphing. Avoid differences which don't have "in-between" values. For
example, delay filter types are chosen from a menu, so you may get a click when
morphing between 2 patches which have different delay filter types, as the morph jumps
from one menu selection to the next.

Patch breeding
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Patch breeding enables you to create new patches which are combinations of existing
patches. To use patch breeding, select the "Breeder" tab in the "Patches" section of the
Modulation page. Select a father patch and a mother patch. Optionally select an amount of
mutation, which will introduce a degree of randomness which is not directly derived from
either the father or mother. Then press the "Breed" button to create a new patch.
(Caution: you can sometimes get unpleasant sounds, so be ready to press Breed again or
choose "Reset" from the utility menu if that happens).

20 Megabyte sample ROM

You may now download and install 20 Mb of multisampled instruments for Crystal, thus
making Crystal a full-featured rompler. Download the mac version of the sample ROM
here., or Download the windows version of the sample ROM here..

Here are the installation instructions:

After you download and uncompress the sample ROM (be sure to check "use folder names"
in winzip when uncompressing), you'll have a folder named CrystalSoundFonts, which
contains three folders, named Ethnic, Orchestral, and Synth, each of which contains one
soundfont (.sf2) file.

On the mac 0S9, put that CrystalSoundFonts folder into the Preferences folder in your
System Folder. On windows, put the CrystalSoundFonts folder into the plugins folder
where you have Crystal.dll. On OSX, put the CrystalSoundFonts folder into the
~/Library/Preferences folder. When you start your VST host, you'll see a third section on
Crystal's Oscillator type menu, which will include the sample ROM sound fonts. The
samples are organized into Ethnic, Orchestral, and Synth categories.

Here is a bank of 50 example patches which demonstrates usage of the sample rom
soundfonts.

One other note for 0S9: be sure to add 80Mb to the memory allocation of your host to
make room for Crystal and the samples.

Performance Tips

Tips for reducing cpu usage:
Turn off unused delays by muting them.
Turn off unused delay filters by setting their type to "Off"
Turn off unused filter envelopes
Turn off unused voices by turning off the voice on/off button in the general
controls
Turn off unused voice filters by setting their type to "Off".
Turn off poly mode if not needed
If poly mode is on, keep release times in the amplitude envelopes no longer than
necessary
Turn off unused modulation matrix entries by setting the source and targets to
“Off".
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Tutorials

Getting Started With Crystal Patch Editing

In this tutorial, we'll make a simple patch, a sound with some changing characteristics.
The goal is to acquaint you with some of the techniques that you can use to create your
own patches with Crystal. Don't worry, this will only serve as an easy introduction to
working with Crystal, so there's nothing to fear.
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Start by launching your VSTi host (I'm using cubase) and loading Crystal. Set it up so that
your keyboard is connected to Crystal and make sure you're hearing the Crystal presets.
Listen to a few of the presets to make sure you've got everything in working order.

To begin with, we'll need a blank canvas on which we'll create our sound. To get a good
starting point, choose one of the presets named "unused", at the end of the presets menu,
which has most of the parameters in a simple state suitable for creating a new patch.

Voices

The controls in Crystal are organized into 5 pages and you select a page by clicking on the
tabs across the top of the window. Click on "Voicel" to go to the page with the controls for
voice humber 1. Notice that the Voice 1 page is organized into 3 regions: Oscillator, Filter,
and Amplitude. The Oscillator controls are used to create the wave that you hear, the
Amplitude controls determine how loud it is at different points in time, and the Filter
controls are used to add and subtract certain frequencies from the wave to give it
interesting characteristics.

Go ahead and play a note. Watch the waveform display while you play a note. As you can
see in the waveform display, what you are hearing is a sawtooth wave, named because
the waveform looks like the teeth on a saw. We want to start with a mellower tone, so
choose "Sine" from the "Type" menu in the "Oscillator" section of the page. Next, choose
"-1" from the "Octave" menu to lower the pitch by one octave.
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Now let's move on to the Amplitude controls which make the sound louder or softer over
time. We won't need all the points that are in the envelope for this example, so choose 5
from the Points menu. Drag the blue point at the left to the bottom of the window and
drag the yellow point to the top until it has a piano-like sound when you play a note.

Next, make the loudness of the voice respond to the velocity of the key press by turning
up the VelSens control. This makes the loudness sensitive to how hard you press a key.
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Next, let's use the filter for Voice 1. Choose "Env On" from the menu at the top of the
Filter section. Choose "5" from the Points menu to reduce the number of points in the
envelope. Turn on the "Sync" button for the filter envelope. This synchronizes the
envelope with the tempo of the song. In this mode, the nhumbers you see in the envelope
(for example the "1") correspond to beats. That means each vertical line you see in the
envelope corresponds to a 1/16 note.

Drag the right-most blue point all the way to the right. Drag the red point to the top of the
window on the vertical line marked "1". This means when you play a note, the end point
will be reached one beat later. Since the red point is all the way at the top, the filter
frequency will be at its maximum value.

Drag the green point to the middle vertical line. This corresponds to a 1/8 note after you
play a note. Drag it downward and watch the parameter display under the Poly button.
Keep dragging it downward until the parameter display shows a value below 1kHz (for
example, 0.98kHz). Now when you play a note, there is a dip in the filter frequency that is
synchronized to the tempo of your song.
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Now, let's duplicate this first voice into Voice 2. Choose "Copy Voice 1" from the Utility
menu to the right of the Poly button. Next, choose "Paste to Voice 2" from the Utility
menu. This makes voice 2 a duplicate of voice 1.

Next, let's make voice 2 slightly different than voice 1. Go to the voice 2 page by clicking
on the Voice 2 tab at the top of the window. Change the waveform for voice 2 by choosing
"Smooth" from the Type menu in the Oscillator section. Notice how you can now hear two
distinct voices when you play a note?
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Modulation

We've got two voices playing. Now let's add some movement to the sound through the use
of modulation. Go to the modulation page by clicking on the Modulation tab at the top of
the window. The Modulation page has a Modulation Matrix section which has six rows with
four controls in each row. Choose "LFO1" from the "Source" menu in the first row and
"Voicel Pan" from the "Target" menu in that same row.

If it isn't already highlighted, click on the "1" button in the LFOs section to view LFO
number 1 (there are a total of 6 LFOs to choose from). When you play a note, notice how
Voice 1 pans from left to right in a motion that corresponds to the purple ball in the LFOs
section. Turn down the Rate control to slow the LFO and notice how the left/right pan of
Voice 1 slows down.

Turn on the "Sync" control for LFO1 to synchronize the LFO with the song tempo. Now
adjust the rate control until the parameter display shows "0.50 cpb". In other words the
pan will go from left to right once per 1/4 note (half a cycle per beat).
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Next, let's add some interactive modulation by controlling the FM Index parameter of voice
2 with a MIDI controller. In the second row of the Modulation Matrix, choose MIDI CC
Learn from the Source menu. Now twirl any knob on your MIDI controller. For example,
move your mod wheel. Crystal will note which MIDI controller you moved and will use that
in row 2 of the Modulation Matrix. Now choose Voice 2 FM Index for the target in row 2.
Try it out by turning up your MIDI controller to add some growl to Voice 2.

Effects

Finally, let's add some echoes to the sound. Go to the Mixer page. There are a lot of
controls there, but don't worry - they are quite simple because they are laid out in a grid
of rows and columns. Add some echo to voice 1 by locating the slider in the "Delay 1
Send" column of the "Voice 1" row and turn it up about half way. Locate the slider in the
"Delay 2 Send" column of the "Voice 2" row and turn it up about half way.

Make the echoes last longer by turning up the Feedback controls in the "Delays" section
for Delays 1 and 2. Congratulations! You've made your first patch with Crystal. Be sure to
save your work, either by saving your song or saving to an instrument file. If you create
your own patches and would like to share them with others, please email them here by
attaching a .fxp or .fxb file to a mail message so they can be included on the "Patches"
page. You'll be credited as the author of the patches, so include information you want
listed in your credit, such as your name or web site.

In this tutorial we've only lightly touched on the basics of Crystal: voice editing, mixing,
and modulation. We've barely skimmed the surface of envelope editting and modulation,
and skipped other parts entirely. But don't worry, more tutorials are on the way.

Patch Management with Crystal's Patch Bank
Browser

In the last mini-tutorial I covered voice copying, and I'll be exploring patch editing in the
future. But, before we get to creating your own patches, here's a tutorial about how to
manage the patches you already have.
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This tutorial uses the patch bank browser in version 2.2.1, so if you haven't downloaded it
yet, get it at the Crystal web site . If you've got the latest version, you should see a
section labelled "Browser" on Crystal's Modulation page.

Getting Started

First, a couple of terminology items: I use the term "patch" to mean a snapshot of of synth
settings. This comes from the old days when synths were programmed using patch cables
to connect one module to another. Another term that means the same thing is "program".

I use the term "preset" to mean a patch which has been loaded into Crystal. Crystal has
room for 128 presets and all 128 form a "bank". This bank of presets is saved with your
song, so when reopen your song, any edits you made to those presets are restored. That's
great because you'll always get your project faithfully restored when you open it later.

However, sometimes you may want to reuse patches that you created in one song in
another song. It is generally difficult to retrieve a preset from one song and use it in
another. That's where .fxp and .fxb files come in. You can save a preset patch to a .fxp file
or the entire bank of presets to a .fxb file.

You can then go to another song and load one patch into Crystal by importing a .fxp file,
or you can load an entire bank of patches by importing the .fxb file. When importing a .fxp
file, the current preset (as selected from the preset menu) is overwritten with the
imported patch. When importing a .fxb, the entire bank of presets is overwritten with the
patches from the .fxb file.

Before we go further, familiarize yourself with a few Crystal controls. The first is the
"Utility" menu. This is the menu just to the right of the "Poly" button. This menu has the
VoiceCopy and VoicePaste items we used in the last tutorial. Below the Utility menu is the
"Presets" menu. It's the downward pointing arrow. When you popup that menu, it shows
you all 128 presets currently loaded into Crystal. To the left of the Presets menu are a pair
of arrows, one pointing left and one pointing right. These step through the presets. On
Crystal's Modulation page you'll find the "Browser" section. This section contains the
"Bank" menu and the "Patches" menu.

Making a Library of Patch Banks
Ok, now that we've got the preliminaries out of the way, let's get going.

Create an empty folder named "CrystalPatchBanks". On the mac, put that
CrystalPatchBanks folder into the Preferences folder in your System Folder. On windows,
put the CrystalPatchBanks folder into the plugins folder where you have Crystal.dll. On
OSX, put the CrystalPatchBanks folder into the ~/Library/Preferences folder.

Now download 4 .fxb files from http://www.greenoak.com/crystal/patches.html by clicking
on the links for "Vintagel", "Ambient1", "Motifs1", and "Factory Presets". After you
uncompress the files, you should have 4 files:

eVintagel.fxb

e Ambient1.fxb

o Motifs1.fxb

e FactoryPresets.fxb

There is also a Crystal21 presets bank on that page, but don't download that. Now, put
these four files into the CrystalPatchBanks folder.

Have Fun With Patch Banks

Now start up Crystal. Crystal comes preloaded with 128 preset patches, so you'll always
find those on the preset menu when you start Crystal. I'm kind of fond of many of those
presets, but there are only 128 to choose from. Having lots of things to choose from is
usually good in life, so we want more patches to choose from. That's where the Patch Bank
Browser comes in.
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Go to the Banks menu in the Browser. On that menu, you'll see the names of the 4 patch
banks you put in your CrystalPatchBanks folder (Don't see them? Then go back and make
sure the folder is named and located according to the instructions above or choose "Banks"
from that menu to refresh the menu.). Choose "Vintagel.fxb". If you click on the
"Patches" menu, you'll now see a list of names, starting with "HackSaw". These are the
names of the patches in that .fxb patch bank file. Choosing a patch from this menu will
load that patch into the current preset. Go ahead and choose "HackSaw". Play a note and
you'll hear an analog-style patch. Also note that the name "HackSaw" now appears in the
Parameter Display below the Poly button. That serves as confirmation that the patch was
imported from the .fxb file into the current preset.

See those two arrows, pointing left and right below the patches menu? Those step through
the patches in the selected patch bank file. Go ahead and click on the right arrow a few
times, playing a note each time to listen to the result. Note how each time you click on the
right arrow, the parameter display is updated to show the name of a new patch. If you
click on the patches menu again, you'll the names of the patches you've been importing.

So what is happening when we import a patch? The current preset is overwritten with the
imported patch. That means if you're looking for several patches to use in your song, you
can browse until you find one you like. Then, change the current patch by using the
presets menu and start browsing again, importing into the next preset slot. Using that
technique you can import up to 128 patches into Crystal's presets.

If you've browsed through the entire "Vintagel.fxb" patch bank file, go to the Banks menu
and choose another bank file and start browsing through that. By doing this you have
hundreds of patches at the tips of your fingers, accessible with just one or two mouse
clicks!

Patch Strategies

If you're like me, you sometimes use Crystal for mutliple parts in a song, using a different
patch each time. You can do this by using multiple instances of Crystal. Using the browsing
described above, you can browse and import a different patch for each instance.

Many times though, you run out of Crystal instances, either because of cpu limitations or
space in Cubase's instrument rack. In that case, the best thing to do is to print the Crystal
part to disk (sometimes called freeze). That way you capture the audio, thus freeing up
the Crystal instance to be used on another part. What I do in this case, is save the midi
track in case I want to go back to it later. I name the midi track with the name of the
patch I used. When I start on the next part, I step to the next preset using the right arrow
next to the presets menu and browse for a patch to use on the next part.

I've done songs where I've repeated this process many times. However, when I save the
song I save all the midi tracks, the audio track for each one, and since the preset I used
for each track is in a different preset slot in Crystal, they are all saved as well.

Other Neat Things

When you import a patch, it overwrites the current preset. What if you did that by accident
and want the overwritten preset? No problem, just choose "Revert" from the Utility menu.

Also, since importing a patch overwrites the current preset, that means the original Crystal
presets will be overwritten as you import patches. What if you later want to use one of
those original presets? No problem. That's why we downloaded the FactoryPresets.fxb
bank. If you browse that bank, you'll find all the original preset patches. In fact, you may
want to load the unused.fxb bank from the yahoo files area into Crystal before you start
browsing. That way you'll only be overwriting unused patches.

Of course, many times when you import a patch, you'll end up tweaking it before you're
happy with it. Because it is imported into a preset, your tweaks will be saved with your
song. But, what if you want to use that tweaked version in another song? No problem.
Notice how the Vintagel, Ambientl, and Motifs1l banks have unused patches? Those are
for you to add your own patches. Say you imported "HackSaw", but tweaked it to make it
just right for your song and now you want to make it easy to use that tweaked version in
another song.
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1. First rename it by clicking on the parameter display and typing in a name, for
example "MyHackSaw".

2. Next save the preset bank to a "MyBank.fxb" file (the exact instructions for this
depend on your host, so see the host documentation) and save that file to the
CrystalPatchBanks folder.

3. Then, load the Vintagel.fxb patch bank using your host's "load patch bank"
(again, see the host documentation for details).

4. Choose the first "unused" prest from the Presets menu.

5. Choose "Banks" from Crystal's Banks menu. This will refresh the Banks menu so it
now shows "MyBank.fxb".

6. Choose "MyBank.fxb" from the Banks menu.

7. Choose "MyHackSaw" from the Patches menu. This will load MyHackSaw into the
preset slot which used to contain the first "unused" preset.

8. Finally, save the preset bank like you did in step 2 to the CrystalPatchBanks
folder, this time giving it the name "Vintagel.fxb". Now that you're done, clean up
by deleting the MyBank.fxb file in the CrystalPatchBanks folder. The end result is
that you've added a patch to the Vintagel.fxb bank, meaning that "MyHackSaw"
will be available when browsing for patches in the future!

Voice Copying

This is a tutorial about voice copying. This is an effective technique that I use a lot, and is
very useful, but it is simple and easy.

I'll be using the "unused" patch for this example. You'll find this at the end of the presets
menu in Crystal. It is like the "blank slate" that thoke referred to when he uploaded his
virgin bank. So, if you're playing along at home, bring up Crystal and choose "unused"
from the presets menu.

Crystal offers three "Voices". A Voice is the source of a sound. Other synths often refer to
the sound source as an oscillator, but in Crystal the oscillator is just one element of the
voice. You can turn the individual voices on and off with the Voice buttons under the logo
on the Crystal window, and you can visit the parameters for each voice by choosing the
Voice tabs at the top of the window.

With 3 voices, there are countless interesting ways to blend sounds. You can blend
contrasting sounds to make intricate patches. For example the "Swept Away" preset uses
3 very different voices to get an evolving sound. Or you can blend similar sounds. The
"Bigness MW" preset blends 3 similar voices, but varies them in ways to get a full sound.

One technique for blending multiple voices to create a fuller sound is detuning. In this
technique, you employ multiple voices which are identical except that the tuning varies
slightly.

This is where voice copying comes in. We want to take the "unused" and give it a fuller
sound by detuning multiple copies of the same voice.

If you listen to "unused", it is a very simple sound, which is the whole idea since it is
intended to be the starting point for patch creation. Let's beef it up a bit by making a
second, detuned voice. Choose "Copy Voicel" from the utility menu, next to the "Poly"
button. Then choose "Paste to Voice2" from the same menu. This copies all the parameters
from the "Voice 1" page and pastes them into the "Voice 2" page. If you flip back and forth
between those two pages, you'll see that they are now identical. If you play a note, it will
sound the same as before, only louder. Now adjust the "Fine tune" parameter on Voice 2
slightly, by turning it up to 0.12. Watch the parameter display under the "Poly" button to
see the value you are selecting. Now play a note and you can hear that it has a fuller
sound.

You can choose "Paste to Voice3", and adjust the "Fine tune" for voice 3 to -0.12 to get a
sound that is fuller still. As you can see on the utility menu, there are also options for
copying voices 2 and 3, so you can copy/paste between any pair of voices.

Voice copying is very useful when working on a patch where the voices are similar. Note
the parameters of the Mixer page are not affected by the paste, so if you're working on a
patch where the only differences between the voices are the routings on the Mixer page,
you can copy and paste the voices without overwriting those settings.
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SawSquare Oscillator Type

You'll find SawSquare in the Type menu in the Oscillator section of each voice page. This
menu controls the waveform which produces the sound for each of Crystal's 3 voices.
You'll notice that the menu is divided into sections. The upper section has synthesized
waveforms and the lower section has sampled waveforms. The synthesized waveforms
give you more control over the sound, but the sampled waveforms, since they are sampled
from nature, are more complex.

If you've added your own samples to Crystal you'll see a third section on this menu which
contains your samples. To learn more about this feature in Crystal, see the SoundFont
section of the Crystal users guide (and there will be a future tutorial on this topic).

Try this: select one of the "Unused" presets at the end of Crystal's preset menu. Select the
"Voice 1" page using the tabs at the top of the window. Choose "SawSquare" from the
Type menu in the Oscillator section of the page. Now play a note. Notice the traditional
square wave sound?

Like many things in Crystal, the SawSquare oscillator type provides a non-traditional
approach to getting unique sounds. Conventional synthesizers offer a square wave and a
sawtooth wave, or perhaps more than one kind of each of these two types of waves.
Crystal offers an infinite variety of combinations of these two basic waveforms.

The Pulse Mix slider controls the blending of sawtooth to square. When this slider is all the
way down (to the left), the waveform is a sawtooth. When it is all the way up, the type is
square. In between values give you hybrid waveforms which blend these two basic
waveforms.

Try this: Make sure you've got the Type set to "SawSquare" and turn the Pulse Mix slider
all the way down and play a note. Note the buzzy, agressive sound you normally associate
with a sawtooth? That's Crystal's special analog-style sawtooth. You can watch Crystal's
oscilloscope and see the jagged shape of the waveform which gives it its name.

Now turn the Pulse Mix all the way up and play a note. Hear the hollow, woody sound of a
square wave? Here's a cool thing about Crystal though: Move the Pulse Mix slider to values
in between these two extremes and you can get an infinite variety of sawtooth/square
hybrid waveforms.

One fun thing you can do with square waves is to vary the width of the square part, or
"pulse" of the waveform. That's what the Pulse Width slider is for. Turn the Pulse Mix slider
all the way up and try moving the Pulse Width slider to different positions. When it is near
the middle, you'll get a thin, reedy sound. When it all the way up or all the way down.
you'll get a woody, hollow sound. Note that with Crystal you get a different kind of hollow
sound when the Pulse Width slider is all the way up compared to when it is all the way
down.

A great way to use the Pulse Width is to modulate it with an LFO. This gives a chorus-type
effect to the sound. Try the "Saddest Strings" patch in the "Pads" section of the preset
menu. This is simply two detuned voices, each playing a square wave which has a
modulated Pulse Width. (See the Voice Copying tutorial to learn about detuned voices
here. )

Fun with Formants: Vocal Sounds with Crystal

In this tutorial we'll look at making vocal sounds with Crystal. Specifically, the sounds will
be vowel sounds, so the goal is to make Crystal go "ooh" and "ah". One note before we
get started: this effort is to get human-like sounds. Crystal is useful for making synthetic
sounds that don't occur in nature. If instead you want truly human vocal sounds, you're
probably better off with a sampler. Although, even with a sampler, realistic human voices
are notoriously difficult to achieve. In this tutorial however, we're aiming to get synthetic
sounds with a vowel-like character.

First a bit of background on that musical instrument in your mouth. The recognizable
vowel sounds of the human voice are due to formants created by various cavities in your
head. A formant is a set of narrow band pass filters. You create this set of filters in your
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head when making sounds by altering the size and shape of empty volumes such as the
nasal cavity, mouth, and pharynx. By using your vocal chords as a sound source, and
passing that sound through one of these formants, you get an interesting variety of
sounds. The formants need not be complex: a set of 3 filters usually suffices to create a
sound that we can recognize as an "ooh" or an "ah".

Crystal is well-suited for this kind of application since it has a bank of band pass filters.
Where, you say, is this filter bank? It is the set of 4 delays. Each delay has a band pass
filter. By simply routing audio through these delays (and setting the delay times to zero,
so that we get no echoes), we get a bank of 4 filters.

To get started, just pick a simple sawtooth oscillator, set the filter bank to the appropriate
frequencies for the desired formant, and route the audio from the voice through the filter
bank. What are the appropriate frequencies for various formants? There are many places
on the web where you can find tables of formant frequencies for various vowel sounds.
Here's a table that you might find useful (from "The Talk Box and Formant Filtering" by
Hans Mikelson):

" n nan n.n "

1 (&

" n._oAn " n n.n "

ae" "ah" aw u 00 u er

"

Vowel ee

270 390 530 660 730 570 440 300 640 490
Male spoken 2290 1990 1840 1720 1090 840 1020 870 1190 1350
3010 2550 2480 2410 2440 2410 2240 2240 2390 1690

300 375 530 620 700 610 400 350 500 400
Male sung 1950 1810 1500 1490 1200 1000 720 640 1200 1150
2750 2500 2500 2250 2600 2600 2500 2550 2675 2500

310 430 610 860 850 590 470 370 760 500
Female spoken 2790 2480 2330 2050 1220 920 1160 950 1400 1640
3310 3070 2990 2850 2810 2710 2680 2670 2780 1960

400 475 550 600 700 625 425 400 550 450
Female sung 2250 2100 1750 1650 1300 1240 900 800 1300 1350
3300 3450 3250 3000 3250 3250 3375 3250 3250 3050

370 530 690 1010 1030 680 560 430 850 560
Child spoken 3200 2730 2610 2320 1370 1060 1410 1170 1590 1820
3730 3600 3570 3320 3170 3180 3310 3260 3360 2160

-4 -3 -2 -1 -1 0 -1 -3 -1 -5
Amplitudes (db) -24 -23 -17 -12 -5 -7 -12 -19 -10 -15
-28 -27 -24 -22 -28 -34 -34 -43 -27 -20

Download the following bank file to get Crystal patches which demonstrate this technique:
Mac Download
Windows Download

If you look at the filter frequencies in the table, notice that these are relatively low
frequencies and are fairly close to the fundamental frequencies around middle C. Since
these filters are very narrow band pass filters, that means that the effective range will not
be very wide. In other words, as you try out these patches, you'll have to hunt around on
your keyboard to find a range where they sound good. The range may only be a few
notes...not unlike the human voice (well, mine at least).

A couple things to note about how these patches were created: First, you want the filters
to be very narrow band pass filters. You can make them especially narrow by turning up
the Q value and by increasing the feedback (be careful about turning feedback parameters
all the way up). Second, once you have the filters configured, route the voice to the filters
and turn off the dry output of the voice. Third, adjust the relative volumes of the filter
outputs to suit to taste.

The "oh" through "er" patches demonstrate a single formant, that is a sawtooth wave
through a bank of 3 filters, with each filter frequency taken from the above table. That's
nice, but Crystal is built for moving, responsive, interactive sounds, so let's make it go
from ooh to ah.
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What we want to do is make the filter frequences go from the values for "00" to the values
for "ah". This is a job for modulation, so go to the modulation matrix and set it up to
modulate, or change, the filter frequencies. There are a number of different ways to do
this with Crystal, but the "ooF-awF MW" patch does it like this: use 3 rows of the
modulation matrix to control delay filters 1, 2, and 3. The low value for each modulation
will correspond to the frequencies for oo and the hi value will correspond to ah.

To do this, simply choose modulation wheel as the "Source" for the first three rows of the
modulation matrix. Set the targets for those three rows to "Delay 1 Filter Freq", "Delay 2
Filter Freq", and "Delay 3 Filter Freq". The mod wheel will now control the filter frequency

values for those three delays.

Now, set the "Low" value for each mod matrix row to correspond to the frequencies for the
male sung u” (400, 720, 2500) and the highs to male sung ah (700, 1200, 2600). Now,
when the mod wheel is all the way down, the formant will be male sung u”~, and when all
the way up will be male sung ah.

Go ahead and try the "oo-ah MW" patch. Hold down a note in the range on the keyboard
where it sounds good, and move the mod wheel up and down. The sound will go from oo
to ah!

Next, instead of using the mod wheel to modulate the filter frequencies, let's use a
modulation envelope. That's what the "oo-ah ME" patch does. It starts out with 0o, goes to
ah, and returns to oo when you release the key.

Next, let's add a bit of chorus by using pulse width modulation. In other words, let an LFO
modulate the pulse width of voice 1. That's what the "oo-ah ME PWM" patch does.

Finally, let's add a second voice harmonized a major 3rd above the original for a 2 voice
harmony. Listen to the "oo - ah ME PWM 2V" patch to hear this.

Experiment with different oscillators as the sound source. Try crossfading two voices based
on note on velocity (see the VelXFade preset for a velocity cross fade example). Instead of
the mod wheel or mod envelope to modulate between oo and ah, try using an Ifo. Try
different amplitude envelopes for the 2 voices. Try...well, you get the idea :-).

How to Make a Soundfont

In this tutorial, we'll make a soundfont, which you can use to extend the set of waveforms
available for use in Crystal.

Before starting this tutorial, be sure to review the "Sample import" and "Oscillator"
sections of the Crystal user guide. The former will explain how to add soundfonts to
Crystal and the latter will explain how to use them in a patch.

Introduction

Before starting the "how to", a few words about the "why". Soundfont is a file format
introduced by EMU systems. It is a sample format which provides support for
multisamples.

Multisamples means you use multiple samples to provide the sound for an instrument.
Why multiple? Because a single sample, such as you find in a WAV or AIFF is generally
insufficient to provide a high-quality sound across the entire keyboard. With a single
sample, a sound which sounds good on one part of the keyboard may sound horrible on
another part. Further, using a single sample leads the rise of aliasing, a nasty sound which
occurs when you play a single sample too far from its original range.

In contrast to single samples, multisamples provide multiple samples across the keyboard,
helping to avoid the problems associated with single samples. Soundfonts provide the
ability to map multiple samples across the keyboard, or even across velocity levels so that
you get a different sample depending on how hard you strike the key.
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Soundfonts are a very flexible format and can include many things, including descriptions
of multiple instruments which may be layered together, envelopes, effects, and much else.
Crystal only uses soundfonts as a source of waveforms, so this additional information is
ignored by Crystal. If you have a soundfont with these extra bits and you'd like to hear the
full soundfont, not just the waveform, try a sampler or dedicated soundfont player like
Jeskola.

Start

Soundfonts are readily available on the internet (see the user guide for places to look), but
what if you have a sound that you would like to use which is not in soundfont format? For
example, you might have an instrument you'd like to record and then use that sound in
Crystal. Or, you might have a audio sample CD you've purchased. Magazines like
FutureMusic or Computer Music come with a cover CD which often includes instrument
(electronic or acoustic) samples which might be useful as waveforms in Crystal. The
following procedure describes how to take any of these sources and convert it into a
soundfont usable by Crystal.

Creating a soundfont is, at most, a 4-step process. Depending on what you are starting
with as your source material you may have to do all four steps, or you might be able to
skip right to step 4. Here are the four steps:

Record performance

Save audio to WAV or AIFF files

Prepare WAV or AIFF files for inclusion in soundfont
Assemble WAV or AIFF files into a soundfont

pPunE

If you're beginning with a WAV or AIFF file which is already looped, you can proceed right
to step 4. If you're beginning with WAV or AIFF file which is not looped, start with step 3.
If you're beginning with an audio CD, start with step 2. And, if you're beginning with a
sound which you will record, start with step 1.

Procedure for creating a soundfont

1. Record performance
If you're recording a performance of an instrument as the source of your audio,
use your digital audio recorder to record a series of 3 or more notes, spaced
evenly across a range of 2 or more octaves. If you are recording a synthesizer, or
something you can trigger via midi, use your sequencer to play the notes so you
can ensure that the note on velocities are consistent. Make sure you get a nice,
loud signal recorded to ensure the best fidelity.

2. Save audio to WAV or AIFF files
If you recorded a performance in step 1, now use your digital audio recorder to
save the audio to a WAV or AIFF file. If the source of your audio is an audio CD,
use a ripper like iTunes or Musicmatch to extract the audio to a WAV or AIFF file.
Even better, if your audio editor (which you will use in the next step) permits you
to import from an audio CD, use that instead. Note that audio sample CD's will
generally provide a set of at least 3 notes with different pitches, which enables
you to use them for a multisample, so if you starting from an audio CD, your WAV
or AIFF file should consist of several notes with different pitches.

3. Prepare WAV or AIFF files for inclusion in soundfont
Ok, now we have the audio of several notes at different pitches, saved into a WAV
or AIFF file. The next step is to prepare it for use in a soundfont. This means we

need to:
o Make the audio mono, if it isn't already
o Slice it into a separate WAV or AIFF file for each note
o Crop it, to remove any silence from the beginning or end of each note
o Loop it, to provide the ability to sustain the note indefinitely

These steps are performed with an audio editor. I'll provide examples for both
mac and windows.
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Mac version

On the mac, there are a number of choices for your audio editor. A couple of the
more popular are BIAS Peak and DSPQuattro. Infinity from Antares is also a good
choice. I'll list the steps to be performed using Peak.
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If you have a stereo file, convert it to mono by doing a File->Export Dual Mono,
then open the Right version of the file you exported. Next, make a mono file for
each note by selecting the audio for each note, excluding the silence before and
after the note, then Edit->Crop, then File->Save A Copy As, then undo the crop.
Repeat that for each note and you should have a mono AIFF file for each note.
Then open each note's AIFF file and, making sure you have "Preference-
>AutoSnapToZero" selected, choose a region for the loop. Find a beginning point
which has a similar waveform appearance as the ending point, then choose
Action->Loop This Selection. Try out your loop by playing the audio with looping
turned on. A good loop has no audible artifacts when the loop jumps from the end
to the beginning. You may have to try various loop points to get a satisfactory
result.

Windows version

On windows, there are many editors to choose from. I can recommend ZeroX
Seamless Looper. Here's the procedure using Seamless Looper.
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Open your WAV file which contains all the notes. Convert it to mono, if necessary
by using Process->Stereo to Mono. Next, select each note in turn and use File-
>Save Selection As to save each note to its own WAV file. Next, open each note
file and crop it using Process->Crop->Start And End. Choose Settings->Sample
and click on "Use detected" to assign base note for this sample. Finally, loop each
note using Loop->AutoSearch with the Whole Sample option. Play the WAV with
looping turned on to ensure that the loop is indeed seamless :-).

Assemble WAV or AIFF files into a soundfontThe final step is to take the
WAV or AIFF files and put them together into a soundfont.

Mac version
On the Mac, I recommend using Polyphontics to create soundfonts.
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You'll see two windows when you start up Polyphontics. Our first step is to import
the AIFF files into the Audio Library. Click on the import button in the Audio
Library window and shift-select the note AIFF files to import them.

Next, create a new instrument in the Document Edit window with the "Create New
Instrument" button. Give it the name you'd like to see in Crystal's Oscillator Type
menu. Next, add the samples to this instrument with the "Add Audio" button in
the Audio Library window.

Next, double click on each sample in the Document Edit window. For each one,
enable looping and set the base note to the note that was originally played when
this note was performed. Then assign the keyboard zone which will play this
sample by clicking and dragging in the keyboard at the top of the window. Click
Ok, then move on to the next sample.

The keyboard zones should be non-overlapping, and the zone for each note should
be in the region of the original note that was played when it was performed. The
result is a mapping across the keyboard with no gaps and each zone plays a note
which was originally played in that zone.

Finally, choose File->Make Sound Bank to export the soundfont file (be sure to
save it with a .sf2 extension) into your CrystalSoundFonts folder. Note that you
can save multiple instruments into a single .sf2 file.
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Windows version

On windows, I recommend using SoundFaction Alive.

To create an instrument, choose File->New Soundfont. Select the soundfont which
appears in the left pane and right click->Import Samples. Choose only the first
note's WAV file. This will create the instrument and load it with the first sample.
Expand the tree view to show the instrument, and right click->rename to give it
the name you would like to see in Crystal's Oscillator Type menu. This picture
shows the instrument renamed to "Glassboom":
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Now, right click on the instrument you renamed, choose Import Samples, and
import the rest of the samples.

Select the instrument and you'll see a zone in the pane in the upper right for each
sample. Adjust the zones for each sample by selecting a sample, then dragging
the zone markers. The zones should be non-overlapping and each sample's zone
should be the vicinity of the base note that was originally played for that sample
(which should be the same as the base note which was assigned in
SeamlessLooper in the previous step), as in the following picture.
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Double click on each sample and make sure the "Loop" option is checked. Finally,
use File->Save As to save the soundfont into your CrystalSoundFonts folder.
Remember to use the .sf2 name suffix when saving. Also note that you can put
multiple instruments into a single .sf2 file.
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Chainer

Note that windows users have another option for creating soundfonts: Xlutop
Chainer. If you're using a VST softsynth as the source of the audio for your
samples, use the standalone version of Chainer to host the VSTi, and use
Chainer's export facility to export a series of notes into a series of .WAV files.
Chainer has an "export soundfont" option, but there are problems with the
soundfont files it creates, so use the .WAYV file option instead. Then follow the
above procedure, starting with step 3. If you're using a softsynth as a source of
your samples, however, you'll need to be aware of the copyright restrictions
regarding the use of those samples.

Congratulations! You've made a soundfont, which will enable you expand the
palette of waveforms to choose from when making your sonic masterpieces with
Crystal.
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